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HOME SCREEN:   
The software opens to a Home Screen and you can choose where you wish to navigate from this 
screen.  

 EMBROIDERY CANVAS takes you to the Embroidery Canvas where you can choose to 
open a design, insert a design, add lettering, or begin digitizing.  

 EMBROIDERY LIBRARY takes you to BERNINA ’s file management system where you can 
select a design from the library, search for a design, convert a design and much more.  

 TUTORIALS will show a listing of tutorials that link to YouTube instructional videos. Se-
lect Tutorials; then click on Featured Tutorials to view the software videos. 

 HELP will open the BERNINA Embroidery Software 9 Help Menu. You must be online to 
view this. 

 On the right, you will find links to projects, Embroidery Online, and BERNINA webinars. Scroll to 
find a link to the BERNINA Blog.  

LEVELS OF SOFTWARE 
 
BERNINA Embroidery Software 9 has two levels: Creator and Designer. Creator is an all-in-
one creative package for creating lettering and monogramming. In addition, Creator has auto-
matic methods of converting artwork into stitches. This level also has some manual digitizing 
tools and basic applique.  
 
BERNINA Embroidery Software Designer level has all the tools and features of the Creator 
level plus more fonts, more stitches, creative effects, and all the manual digitizing tools.  

 

Introduction to Software Screens 
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GENERAL INFORMATION  
 
The next few pages contain information about the Embroidery Canvas screen and the icons you 
will find on the screen. These pages can help you learn about the icons and what they do. 
 

 Resting your cursor on an icon will display the name of the icon.  
 After resting your cursor on an icon, pressing F1 (or FN + F1 on some computers) will 

open an appropriate page of the Help Menu.  
 If you wish show tool names all the time, click on Options> General Tab. Place a check 

mark by Show Tool Names and click OK.  
 The name of the icon will be placed under each of the icons on the Embroidery Screen.  
 When you add icon names, some of the icons will be hidden.  
 To show the hidden icons, click on the drop-down arrow at the end of the toolbar. All 

icons that are hidden in that row will be shown in a drop-down bar.  
 
 
 
 
 
 
 
 

SCREEN DISPLAY 
 

Title Bar:   
 
This bar will display the name of the design and level of the software.  

 
 

Menu Bar:  
 
  
 
This has pull-down menus to access various software features. Many of the fea-
tures also have corresponding short-cut icons.  

 
 
 

Canvas Toolbar:   
  
 
 

This toolbar toggles between Artwork Canvas, Embroidery Canvas, and Embroi-
dery Library. You can convert a selected embroidery design to vector artwork by 
clicking on the Convert Embroidery to Artwork icon.  

 
 
 

Tour of Screen  
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General Toolbar 

 
 
 
The General Toolbar contains basic Windows tools, such as Cut, Copy, Paste, as well as 
icons that launch special dialog boxes and docker dialog boxes within the software.  

 

 
 
 
Zoom Toolbar:  

  
 

The Zoom Toolbar will change the zoom level on screen and the Pan icon can be used to 
move the design on the screen without changing the zoom level. You can select the Zoom 
icon and left click on the design screen to zoom in, right click on the design screen to zoom 
out, or click and drag a box around an object to zoom in on that object.  
 
Additionally, you can zoom to the selected object, zoom to article, zoom to fit the screen, or 
zoom to the hoop. In order to zoom to an article or hoop, those must be visible on the 
screen. To zoom to a selected object, an object must be selected.  
 
A quick way to zoom to selected is to right click on an object and select Zoom to Selected. 
 

 
Travel Toolbar:  
 

 
  The Travel Toolbar lets you travel through a design object by object, color by color, or to the 

start or end.  
 

 
Transform Toolbar 
 

This toolbar is used in editing your design. There are icons to resize, mirror, rotate, skew de-
signs and change their positions. The last section of this toolbar lets you rotate the hoop by 
15 degrees or by a specified amount.  
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Tour of Screen 

 
View Tool Bar:   

 
The View Toolbar contains icons to change your view on the design screen. Blue highlight-
ed objects are active icons.  

 
 
 
 
 
Toolboxes:   
 

On the left of the screen, there are toolboxes. By clicking on the title bar of the toolbox, the 
icons grouped in that toolbox will appear.  
 
When a toolbox is opened, a scroll bar on the right side of the toolbox area lets you scroll to 
other toolboxes. 
 
Icons that are grayed out are not activated until something is selected, or this may mean 
that particular tool cannot be used on the item that was selected.   
.  
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Color Toolbar:   

 The Color Palette Toolbar is below the design screen.  
 Available colors from your default palette are shown when you open a new blank 

design. If you open a design, rather than insert a design, only colors used in the 
design are shown. The colors used in the design are designated by a blue box in 
the upper right-hand corner of the color chip.  

  
 With the Pick Color icon, you can select a color by clicking on a color that is part 

of an object. The symbol changes into a paint bucket icon and you can change 
another object to the selected color by clicking on the new object. 

 
 The Apply Current Color icon allows you to change a color in the design to the 

color currently selected in the palette. The Current Color is shown in the color 
chip just to the right of Apply Current Color icon. 

 
       The Current Color is shown after Apply Current Color. This shows the color that 

will be applied to a digitized object. It is also highlighted by a black outline in the 
Color Toolbar.   

 
 The scroll arrows at the end of the toolbar will show additional colors. There are 

56 default colors in the BERNINA color palette, which is the default color palette.  
     

  
 Add colors to the palette by clicking on the plus sign; delete the last color in the 
    palette by clicking on the minus sign.  
 

 
    Hide the unused colors by clicking on Hide Unused Colors. Bring colors back by 

clicking on the icon again. Remove Unused Colors removes color chips from the 
palette. Bring the colors back by clicking Undo.  

 
 

 Cycle Used Colors, at the end of the Palette, assigns the colors used in the de-
sign to different objects in the design.  

 
 Color Wheel will change the color of individual parts of a design or the design in 

total to new colors. 
 
 A left click on My Threads/Thread Colors will open the Threads Docker while a 

right click will open the Design Properties dialog box, Thread Colors tab.  
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Stitch Bar:  At the bottom of the screen, you will find a selection of stitch types. There 
are outlines, fills, and effects.  

 
 
 
 
Docker Tabs & Icons:   

  There are Docker tabs on the right side of the screen. The 
number of tabs will be determined by which dockers you 
have activated and by the level of software. Many of the 
dockers are opened by icons in the General Toolbar; some 
are activated by icons in the Toolboxes. 

 
Rest your mouse on one of the tabs to display the docker dialog box.  

  
 
  

 Dockers will be hidden and shown as tabs if the Auto Hide (thumbtack icon) is 
turned on its side. The Dockers will remain open if the Auto Hide icon is in an 
upright position.  

 
 To close the docker, click on the X in the upper right-hand corner of the title bar. 

To reopen, click on the corresponding icon in the General Toolbar.   
 
 Docker dialog boxes can be moved to any position on the screen by clicking on 

the title bar of the dialog box and dragging it to another position. This can only 
be done if the Auto Hide icon is in an upright position. To re-dock the dialog box, 
double click on the title bar.  

 
 
Status Bar:   
 
 The Status bar is located at the bottom of your screen. The left side of the status 

bar will give you information about the next step in the process for your selected 
icon, if appropriate.  

 
 On the right side of the status bar, you will see information about the design; in-

cluding size, location, number of stitches, type of fabric (if one has been selected) 
and design grade (indicating the editing capabilities of the design).  
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Toolbox Icons 
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Toolbox Icons 
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Additional Tools in DesignerPlus vs Creator 

Additional Outlines 
 Blackwork Outline 
 Candlewicking 
 Pattern Run  

 
Additional Fills 
 Sculptured Fancy 
 Ripple 
 Contour 
 Blackwork 
 Candlewicking 
 Lacework 
 Pattern Fill (more types in DesignerPlus)  
 Cross Stitch 
 Stipple 
 Stipple Stemstitch  
 Stipple Backstitch 
 

Additional Effects 
 Automatic Corners 
 Calligraphy  
 Couching 
 Elastic Fancy Fill Effect 
 Gradient Fill Effect 
 Star Fill 
 Three-Dimensional Globe Effect  
 Wave Fill 

Additional Dockers & Features 
 Carving Stamp 
 StumpWork 
 CorelDRAW SE 
 49 more fonts   
 Articles 
 
Additional Editing Tools  
 Add/Remove/Fill Holes 
 Double Run 
 Blackwork Run 
 Color Blending 
 Quilting Backgrounds 
 Create Trapunto Outlines 

 
Additional Digitizing Tools 
 Open Freehand 
 Closed Freehand 
 Block  
 PunchWork 
 Pattern Stamp 
 Basting Stitch Marker 
 Insert Graphic Marker 
 

Additional Lettering Tool 
 Keyboard Design Collection  
 

Additional Applique Tools 
 Advanced Applique  
 Remove Applique Overlaps 
 Combine Applique  

 

Additional CutWork Tools 
 Cut Buttonhole Slit 
 

Additional Toolboxes 
 Layout 
 Multi-Hooping 
 Applications  

 Quilter 
 Cross Stitch  
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Create a Custom Keyboard Design Collection 
 You must first create a custom Keyboard Design Collection to 

store your characters. This can be done in the Embroidery 
Canvas or through the Embroidery Library.  

 The basic steps of the process include: 
 Create the collection.  
 Name the collection; set Reference Height. 
 Select the Filter Type. 
 Select the characters to map. 
 Map the characters. 
 Test the font.  

 
 

Batch Mapping 
 Open Embroidery Library.  
 Locate the folder containing the designs you wish to map in the 

navigation pane in the Navigation tree. Open Public Embroi-
dery> BERNINA 9 Embroidery> Alphabets & Monograms> 
Damask Alphabet. 

 Open the Keyboard Design Collection docker by clicking on the 
icon at the top of the Embroidery Library.   

 Select the letter M in the Design Display.  
 Click on New in the docker to add the collection to the drop-

down list. A dialog box opens. The collection is named accord-
ing to the file name in the library.  

 Click on Use Selection and click OK. 
 

 Select the first character to map (A) in the Design Display 
screen; hold the Shift key; and select the last character to map 
(Z).  

 Select the corresponding batch mapping button (A-Z).  
 The slots populate with the characters. 
 This maps all the selected letters.  
 Switch to Embroidery Canvas.  

Notes: 
 

Lesson covers: 

  Mapping Keyboard Design Col-
lections 

 Editing the letters of the collec-
tions  

 
 
The Keyboard Design Collection fea-
ture allows you to map existing em-
broidery character designs to the 
keyboard.  
 
 
Use this method to quickly map char-
acters that don’t need to be edited. 
 
Original design colors and properties 
will be maintained while mapping 
unless edited.  
 
 
 
 
 
 
 
 

Mapping Keyboard Lettering 
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Mapping a Letter in the Design Workspace 
 See the information in the Notes for when to use this method.  
 Open the character in the collection you want to add by 

selecting Insert Embroidery. For this exercise, navigate to 
Libraries> BERNINA 9 Embroidery> Alphabets & Monograms> 
12488 Charming Numbers. Select 12488-09. Click on Open.  

 Edit the number as desired. Change the colors of the design. 
Resize using the Size –10%.  

 Make sure the number is selected.  
 Click on Keyboard Design Collections in the Lettering/ 

Monogramming Toolbox.  
 Click on New. Name the Collection, Charming Numbers Edited.  
 Click on Use Selection to use the height of the selected 

character. Click OK.  
 Click on the Filter By list in the Keyboard Design Collection 

docker to select how you want to filter the available characters.  
 Select Numbers and the dialog box will show only those 

characters. 
 Select the corresponding slot, number 9.  
 Click on Map. The character is added to that design collection.  
 Delete the design on the screen and repeat the process for 

other characters in the collection you wish to edit.  
 
 

Editing the Keyboard Design Collections  
 If you make a mistake while mapping, select the character you 

wish to remove from the mapping and click on the Remove 
Mapping button at the bottom of the docker. A dialog box 
appears so that you can confirm the deletion. This will clear the 
slot and you can correct the mistake. 

 If you accidently have the same slot selected when mapping, a 
warning will appear to ask if you are sure you want to overwrite 
the existing mapped design.  

 If you wish to rename a collection, click on Rename at the top of 
the docker.  

 If you wish to delete a collection, click on Delete at the top of the 
docker.  

 Copy can be used if you want to base a new collection on an old 
collection.    

 
 

Testing Your Collections 
 Right click on Lettering in the Lettering/Monogramming Toolbox.  
 Place a dot in front of Keyboard Design Collection in Object 

Properties to restrict the list to keyboard fonts.  
 Select the Keyboard Design Collection you wish to use 

from the Font list.  
 Enter the characters in the Lettering box using keyboard 

strokes.  
 Edit the letters as desired—the spacing, the slant, the 

size, the baseline.  
 Click OK; click on the screen to generate the lettering. 

Notes: 
 

 Use this method to quickly map 
only certain characters in the col-
lection. 

 

 Use this method when you want to 
edit the characters first before 
mapping.  

 

 Use this method to add a character 
to a collection that has already 
been mapped.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 

 
 
 

 
 
 
 
 

 
Once the collections are created, you 
can experiment with editing. The 
success of editing depends on how 
the collection was digitized.  
 
Resize non-ART collections with 
caution.  
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To Fine-Tune Baseline & Spacing Settings 
 Open the Keyboard Design Collection Docker. 
 Select the collection you wish to adjust from the drop-down 

choices under Collection.  
 Change the selection in the Filter By drop-down if necessary. 
 Select the character you want to adjust in the Keyboard Design 

Collection docker.  
 Click the Adjust Baseline & Spacing button at the bottom of the 

docker.  
 A dialog box opens.  
 You can view the letter in either Artistic View or Design View by 

clicking on the icon at the top.  
 You can also Zoom in.  
 Click and drag the vertical guidelines to adjust the spacing on 

either side. The line turns blue when the guideline is changed.  
 Click OK. Note that Undo does not work with this change, you 

must click and drag on the slider again to adjust.  
 Click and drag the baseline to adjust the baseline. The line turns 

yellow as the guideline is being changed.  
 You may click Cancel if you don’t wish to make the change. 
 
 

Notes: 
 
The spacing and baselines of the 
individual letters can also be adjust-
ed.  
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Multi-colored fonts can be broken 
apart to re-sequence.  
 
 
Scalability depends on quality of the 
original characters. Grade A designs 
can be rescaled +/- 20%. Grade B, 
C, and D designs can be rescaled +/- 
10%.  
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Editing Stitch Types  

Open a Blank Design File 
 Click on the New Blank Design icon or select File> New. 
 Select File/Save As.  
 Name the file, Editing Stitch Types.  
 Select Insert Embroidery.  
 Navigate to Libraries> Embroidery> BERNINA 9 Embroidery> 

Getting Started.  
 Select Sample—Artistic Stitch Effects. Select it; click Open.  

 
Changing the Hoop Size  
 Right click on Show Hoop.  
 Select BERNNA Midi Hoop, 165 x 265.  
 Place a check mark by Show Hoop. Click OK.  

 
Changing the Background 
 Select Design> Background and Display Colors. 
 Place a dot by Factory Article.   
 Click on the drop-down arrow by Name and choose, Ladies> 

Sweatshirt> Hooded Back.  
 Choose a color for the sweatshirt from the Color 1 choices. 

Click OK.  
 In the Zoom Toolbar, select To Article. 
 Click and drag on the design to place it where you would like it 

to be. Use the ruler at the top of the screen to center the de-
sign. 

 Resize the design by selecting it and changing the Width to 
6.25”. Press Enter to activate the change.   

 
Editing a Fancy Fills & Pattern Fills  
 Deselect the design by clicking outside the black boxes, hold 

the Alt key, and double click on the large Fancy Fill heart.  
 Object Properties will open.  
 To select a new fill, click on the drop-down arrow by Pattern 

and select, 173 Tile 1.  
 Change the Size X, Size Y, Column Spacing, and Row Spacing 

to 5 mm. Press Apply.  
 Deselect this fill by clicking outside the hoop.  
 Hold the Alt key and select the small heart fill in the neighbor-

ing heart.  
 Press the T on the keyboard to switch to Design View.  
 Notice that the Fill type is a Pattern Fill.  
 Click on Select in the Object Properties dialog box.   
 For Pattern Set, choose Decoration from the drop-down menu. 
 Select pattern # 522. Click OK; then Apply. 
 Make these changes to the size: 

 Pattern X:  0.58 
 Size Y:  0.41  
 Column Spacing:  0.58  
 Row Spacing:  0.41 

 Press Apply.  

Lesson covers: 

 Working with articles 

 Changing the fill type 

 Editing fills and outlines  

 Working with Object Properties 

 Outlines & Offsets 

 Blackwork Run 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Holding the Alt key lets you select a 
part of a grouped object.  
 
By changing all these values to the 
same amount, the pattern will main-
tain its proper proportions since all 
these were the same value in the orig-
inal fill. The pattern will just be small-
er.  
 
Always pay attention to the relation-
ship of the original values if you wish 
to keep the look of the original pat-
tern. 

Notes: 
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Editing Ripple Fills 
 Deselect the heart.  
 Hold the Alt key and select the Ripple Fill (the heart on the far 

right).  
 Change the Stitch Spacing to 3.5 mm. This will add space be-

tween the rows of the ripple fill. Press Apply.  
 
 

Editing Lacework Fills 
 Deselect the heart.  
 Hold the Alt key and select the Lacework Fill (to the left of the 

yellow heart).  
 Click on Select.  
 Select L0003a.  
 Click OK. This closes the dialog box. 
 
 

Editing Satin Outlines 
 Deselect; then hold the Alt key and click on the pink outlines in 

Color Film.  
 Notice that these are Satin Fills and not outlines. The Satin Fill 

icon turns blue; not the Satin Outline in the Stitch Toolbar.  
 While they are selected, press the Delete key.  
 Click on one of the hearts. Since the hearts are still grouped, all 

hearts are selected.  
 In the Edit Toolbox, select Outlines & Offsets.  

 Check Object Outlines.  
 Select Stemstitch from the Types.  
 Select the color you wish to use for the outline.  
 Select Trimmed Outlines for overlapping choice.  
 Check Offset Outlines.  
 Change the Offset to 0.15”.  
 Change the count to 1.  
 Choose a Triple stitch and select another color.  
 Choose Common Offsets.  
 Uncheck Include Holes.  
 Click OK.  
 This will take a short time to generate.  

 
 

Applying Blackwork Run 
 With the change of outline, there are a lot of jump stitches in the 

outline.  
 Switch to Design View by turning off Show Artistic View to see 

the jump stitches.  
 Select the Stemstitch outlines in Color Film.  
 Click on Blackwork Run in the Edit Toolbox and press Enter.  
 The software adds travel stitches and eliminates the jump stitch-

es in the outline.  
 Save the file as Editing Stitches.  

Notes: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Icons turn blue when activated.  
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Introduction to Manual Digitizing  

 

Digitizing is the conversion of a graphic or drawn image into a data format that embroidery 
machines understand. Data is entered into the computer; then the data is defined to repre-
sent stitch types, stitch directions, stitching sequence, density settings, and other types of 
information for the design. 

 

 The digitizing tools are used to set stitches for all the outlines and shapes in a design.   
 In manual digitizing, every object must be defined by one of the tools.  

 
 

You can create designs in Software 9 using the manual digitizing tools while using artwork 
as a backdrop. Outlines of objects are created using right and left clicks around the ob-
jects. You have the choice to fill these areas with filled stitches or leave them as outlines 
around the objects. Only closed objects can be filled. 
 
 

Manual Digitizing Tools 
 
There are seven basic types of manual digitizing tools in Software 9. These are accessed 
in the Digitize Toolbox. Practice drawing each of the shapes before completing the Digitiz-
ing exercise. 
 

 Open Object Tool:  Used for drawing outlines that don ’t enclose a shape, but 
are left open. The outline of the object is drawn with right + left clicks. Press Enter to 
finish. A left click forms a point or changes direction; a right click forms a curve. It 
takes three clicks to form the shape of the line.  

 
 
 
 
 
 

 Closed Object Tool:  Used for drawing filled or outlined objects that enclose a 
shape. The closed shape is drawn with right + left clicks. After clicking to form a 
shape, when you are close to the point where you started, press Enter to enclose 
the shape.  

 
 

 
 
 
 

 Open Freehand Tool:  The open outlined shape is drawn by clicking and drag-
ging on the screen vs. using right/left clicks. When the mouse is released, the line is 
drawn.  
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Introduction to Manual Digitizing  

 Closed Freehand Tool:  Used for drawing filled or outlined objects that enclose a 
shape by clicking and dragging on the screen vs. using right/ left clicks. An anchor point 
is set; then the mouse is moved around the perimeter of the shape.  

 
 
 
 
 
 
 
 

 Block Tool:  Used for drawing filled or outlined objects that set multiple angles 
within the object as it is digitized (for filled objects), using right/ left clicks that alternate 
sides. The lines that you see across the object show the changing stitch angle for filled 
object.  

 
 
 
 
 
 

 Ellipse:  Used for drawing circles or ovals. Click in the center of the circle, drag to 
the circumference desired, click again and press Enter. An oval is drawn with three left 
clicks and an Enter. Click one is in the center and clicks two and three define the outside 
edges of the oval.  

 
 
 
 
 
 

 Rectangle:  Used for drawing rectangles or squares. Holding the Ctrl key with the 
Rectangle tool creates a square. Click, drag to the lower right, click again to generate 
the shape.  

 
 
 
 
 
 
 
With manual digitizing, you want to start with objects in the background and work toward 
objects in the foreground. It helps to develop a plan—it will save you time in the long run. 
Continued practice and experience will help you learn the basics of manual digitizing.  
 
After choosing the tool to use for digitizing, select the type of stitch and the color of stitch 
desired and start clicking! 
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Introduction to Manual Digitizing  

 Fill Stitches: 
There are fifteen types of fill stitches in DesignerPlus 9. These are accessed by shortcut 
icons at the bottom of the design screen or through Object Properties, Fill Tab. When 
you manually digitize designs, you choose the type and properties of the fill or outline, 
the color of the object, and the angle of the stitch for fill stitches. These decisions can be 
made prior to digitizing an object, or they can be changed after the object is digitized.  
 
Types of Fill Stitches:   

 Step Fill 
 Satin Fill 
 Raised Satin Fill 
 Fancy Fill 
 Sculptured Fancy Fill 
 Ripple Fill 
 Contour Fill (doesn’t work with Closed Freehand tool) 
 Blackwork Fill 
 Candlewicking Fill 
 Lacework Fill 
 Pattern Fill 
 Cross Stitch Fill 
 Stipple Run 
 Stipple Stemstitch 
 Stipple Backstitch 

 
 

Outline Stitches: 
There are twelve types of outline stitches in DesignerPlus 9. These are accessed by 
shortcut icons at the bottom of the design screen or through Object Properties, Outline 
Tab.  
 
Types of Outline Stitches:   

 Single Outline 
 Triple Outline 
 Sculptured Run Outline 
 Backstitch Outline 
 Stemstitch Outline 
 Zigzag Outline  
 Satin Outline 
 Raised Satin Outline 
 Blanket Outline 
 Blackwork Outline 
 Candlewicking Outline 
 Pattern Run Outline 
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Digitizing  

Open a Design File 
 Click on New Blank Design.  
 Select File> Save as and name the file Digitizing Tools.  
 Select Insert Artwork.  
 Navigate to the BERNINA 9 Picture folder (C:  Users> Public> 

Public Pictures> BERNINA 9 Pictures> Artwork> 03_BERNINA 
heart).  

 Select Multicolored Heart with straight edges.png. Click on Open. 
 

Decisions for Digitizing  
 Decide on the stitch order. Objects in the background should be 

digitized first.  
 With the heart design, if you are going to fill in the solid 

areas of the heart with fill stitches; these need to be done 
before the outlines through the heart are digitized.  

 The border around the heart will be the last item digitized.  
 Decide on the colors you wish to use. You don’t have to use the 

colors in the image. 
 Decide on the stitches you wish to use.  
 Decide on the tools you will use to complete the design.  
 For each design segment, you will choose a tool, a color, and a 

stitch.  
 You can preselect the color and the stitch, or you can edit the 

object after creating it.  
 Resize the image prior to digitizing. With the image selected, 

increase the % in the Transform Toolbar to 150%. Press Enter.  
 It is always a good idea to lock the image in the background so 

you don’t accidently move it.  
 Right click on the image and select Lock.  
 
Using the Closed Object Tool  
 Select the Closed Object Tool in the Digitize Toolbox.  
 Select the color you wish to use.  
 Select the Lacework Fill in the Stitch Toolbar. This will apply the 

default Lacework Fill to the object.  
 Zoom into the lime green area.  
 Digitizing tips include:   

 Left clicks create corners and change directions; 
right clicks create curves.  

 A line doesn’t take shape until three clicks are set.  
 Use as few clicks as possible to form the shape.  
 Backspace will erase a click; Esc lets you start 

over. 
 Always press Enter and let the software close the 

shape when you get close to the original point.  
 Digitize around the shape. (See first illustration).  
 Notice when you finish, the Closed Object tool is still 

selected and the object is not selected. 
 You can choose your next type of fill and your next 

color and digitize the next object.  

 

Notes: 
 
Lesson covers: 

 Learning the digitizing tools  

 Digitizing guidelines 

 Reshaping 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you hold your mouse on the area 
you wish to zoom; then use the 
mouse wheel, you will zoom in on 
that area of the artwork.  
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 Complete all the filled-in areas, experimenting with different 
colors and fills.  

 Ignore the orange border design of the artwork and digitize the 
yellow shape and the red shape to meet the green and blue 
shape.  

 Don’t worry about editing the fills; this will be done later.  

  
 
Reshaping 
 Click on Show Bitmap Artwork to hide the image. This makes it 

easier to see what needs to be reshaped.  
 You can also choose to hide the stitches by clicking on Show 

Stitches. This leaves only outlines around the objects. 
 Reactivate Show Stitches.  
 To fine-tune the digitized objects, you can use Reshape. 
 Select the item you wish to reshape.  
 You will notice that symbols appear around the selected shape. 

These symbols represent the following: 
 Green Square:  Start point of object 
 Red Cross:  End point of object 
 Yellow Square:  Left click  
 Turquoise Circle:  Right click 

 When you use Reshape, you can:   
 Move a digitized point by clicking and dragging on the point. 
 Add another point by right or left clicking on the outline 

defining the shape. A left click adds a yellow square reshape 
point; a right click adds a turquoise circle reshape point.  

 Delete a point by clicking on the point and pressing Delete.  
 Change a point by selecting it; then pressing the space bar. 
 Move the starts and stops.  

 Usually when filled shapes are digitized next to one another, a 
slight overlap is preferred because the fabric pulls when 
embroidered. Since these shapes are covered up with outline 
stitches and they are open fills, this is not necessary.  

 Reshape any objects that need to be reshaped.  
 After reshaping, press Esc.  
 Click on Show Bitmap Artwork to bring back the picture.  

 
 

Digitizing with the Open Object Tool  
 Straight lines are created with two left clicks, while curved lines 

are created with right clicks.  
 All the lines in the center of the heart will be created with two left 

clicks.  
 Begin with the line in between the lime green and blue section. In 

the Digitize Toolbox, select the Open Object tool.  
 Select a color.  
 Select the Stemstitch in the Stitch Toolbar.  
 Click along the line with two left clicks and then press Enter to 

generate the line. 
 Remember you can click on Show Stitches to hide the stitches if 

it makes it easier to digitize the outline.  

Notes: 
. 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
In Reshape mode, pressing the Tab 
key will take you to the next object 
that was digitized. Shift + Tab will 
take you to the previous object.  

Color Fill used in sample 
on previous page  

Periwinkle Ripple 

Red Pattern Fill 

Yellow  Candlewicking Fill 

Aqua Ripple 

Purple Blackwork Fill 

Green  Cross Stitch Fill 
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Using a Pattern Stitch  
 To preselect a pattern stitch, right click on the Pattern Run to 

open Object Properties.  
 Click on Select.  
 Activate True View by clicking on the red leaf shape in the upper 

right corner.  
 Click on the drop-down Pattern Set arrow and choose Home 

Dec. Select stitch # 414. Click OK. 
 Change the Size and the Spacing to .45”; then Apply.  
 Digitize the line between the aqua and green section.  
 The colors of the pattern stitches will be changed after they are 

digitized.  
 Choose patterns that are satin stitches or are dense enough to 

hide the seams between the fills. 
 Some suggestions to try include:  (see illustration)   

 Pattern Set:  Home Dec: # 405 
 Pattern Set:  BERNINA V5: # NP005-04 
 Pattern Set:  Heirloom: # 711 
 Remember to select OK; then Apply before you digitize the 

outline for the pattern stitches.  
 For the wide orange line, choose a satin outline from the drop-

down choices for the Outline Type. Click OK. 
 Click on Show Bitmap Artwork. 
 Change the colors as desired and reshape and move the outlines 

if needed through Reshape. Press Esc when finished.  
 

Adding an Outline Around the Heart 
 Select the Single Outline in the Stitch Toolbar. 
 Select a contrast color.  
 Select the Open Object tool.  
 Digitize around one half of the heart along the straight edge and 

not the scalloped edge border. Press Enter.  
 Press Esc. Select the object and Reshape if needed.  
 Press Esc. 
 Select the outline; select Copy; then Paste.  
 Select Mirror X. 
 Right click on the outline heart in Color Film and select Hide Oth-

ers. 
 Deselect and select the mirrored copy of the heart.  
 Move the copy using the left arrow key on your keyboard to meet 

the other side of the heart. 
 Zoom in to make sure the nodes at the top and bottom meet.  
 Reshape if needed; press Esc.  
 Select Ctrl + A.  
 Click Weld in the Edit Toolbox.  
 Right click on the Pattern Run in the Stitch Toolbar.  
 Click on Select.  
 Click on the drop-down Pattern Set arrow and choose Home Dec.  
 Select stitch # 407. Click OK; then OK again.  
 Right click on one of the objects in Color Film and select Unhide 

All.  
 Select Design> Optimize Color Changes. Click OK. 
 Select Save.  

Notes: 

Apply keeps the Object Properties 
dialog box open while OK will close 
the dialog box. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Optimize Color Changes will com-
bine thread colors that can be com-
bined, creating a more efficient   
stitch-out.  
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Quilting Effects  

 

Notes: 
 
Lesson covers: 

 Defining Quilt Blocks  

 Quilting Backgrounds 

 Blackwork Run 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If the desired number is not 
listed in the Work Area Margin 
Box, type the desired amount 
in the dialog box; press Enter 
to activate the number; then 
click on the design screen to 
set the desgins.  
 
 

 
 
 
 

 
Holding the Shift key resizes a 
design from the center of the 
design.  
 
 

Creating a Quilt Block  
 Select New Blank Design.  
 Open the Layout Toolbox. 
 Click on Define Quilt Block. A dialog box will open.  
 Change the Width to 11” with Proportional Scaling in the locked 

position. 
 There should be a check mark by Show Quilt Block. This will give 

you a visual of the total area of the quilt block.  
 Click OK. 
 

Adding Embroidery 
 Select Insert Embroidery. 
 Navigate to Libraries> Embroidery> BERNINA 9 Embroidery> 

Decorative Accents. 
 Open HT102. 
 In the Transform Toolbar, change the % of the Width to 90%. 

Press Enter.  
 While the design is selected, select Rotate Left three times to ro-

tate the design so it is oriented to the left corner.  
 The Quilt Block layout uses the lower left corner as a reference to 

place designs around the layout. 
 Right click on Show Hoop.  
 Select BERNINA 8 Series> BERNINA Jumbo Hoop, 256 x 400. 

Click OK.  
 

Creating the Corner Layout 
 With the design selected, click on Layout to Rectangular Quilt 

Block Corners to set the corner designs. 
 You can set the distance the corner designs are set from the quilt 

block edges by changing the distance in the Work Area Margin 
box. 

 Click on the drop-down arrow and select the distance.  
 Choose 35 mm. 
 There is an outlined preview of the positioning of the design. 
 Click on the design screen to set the design around the corners or 

press Enter. 
 
 

Adding a Center Design & Resizing  
 Select Insert Embroidery. Open HT105. 
 Click on Open.  
 The design is centered in the quilt block.  
 Zoom into a corner.  
 While the center design is selected, hold the Shift key down and 

resize using a corner control handle by dragging toward the center 
of the hoop.  

 Zoom in on one of the corners of the inserted design for accuracy. 
 Release the mouse when the tip of the second design intersects 

with the base of the corner design.  
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Blackwork Run 
 Select Ctrl + A.  
 In the Edit Toolbox, select Blackwork Run. 
 Click in the center of the design to apply Blackwork Run. The 

design will start and stop from this point. 
 Blackwork Run eliminated the jump stitches in the design and 

the design will stitch a double run outline.  
 
 
 
 
 
 

Adding a Quilting Background  
 Select Quilting Background in the Edit Toolbox.  
 Change the block size to 9.5”. This will keep the 

stippling within the boundaries of the Jumbo 
Hoop.  

 Proportional Scaling is locked by default.  
 Select Stipple for the Quilting Type.  
 Change the Design Margin to .079”.  
 Change the Block Margin to .079”. 
 Change the Line Spacing to .15”.  
 Select a Color.  
 Click OK.  

 
 
 
 
 
Deactivating Show Quilt Block  
 Click on Show Quilt Block to deactivate the quilt block visual. 
 Save the design as Quilting Effects.   
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Setting Up the Background for Digitizing  
 Click on New Blank Design. 
 Select Insert Artwork. 
 Navigate to Libraries> Pictures> BERNINA 9 Pictures> Artwork. 
 Select the WMF folder. Locate Elephant.wmf. Open the picture. 

Deselect.  
 

Open Object Digitizing  
 Objects must be digitized from background to foreground.  
 Select the Open Object Tool from the Digitize Toolbox. 
 Right click on the Stemstitch Outline in the Stitch Toolbar.  

 Change the Spacing to 1 mm. 
 Change the Angle to 65 degrees. Click OK.  

 Select Color 14 in the Color Palette Toolbar.  
 Zoom in for accuracy. 
 Using right and left clicks, digitize around the elephant’s ears, 

beginning and ending at the edges that connect with the face.  
 Press Enter to activate the shape. Repeat for the opposite ear.  
 Using right and left clicks, digitize around the elephant’s face, 

beginning and ending at the edge of trunk.  
 Press Enter to activate.  
 Press Esc.  
 

Closed Object Digitizing  
 Select the Closed Object tool.  
 Select the Stemstitch Outline.  
 Using right and left clicks, digitize around the elephant’s trunk.  
 Press Enter to enclose the object. Press Esc.  
 Double click on the trunk to open Object Properties.  
 Change the Angle to 90 degrees. Click OK. 
 Press Esc.  

 
 

Add the Eyes 
 Select the Ellipse icon in the Digitize Toolbox. 
 Select the Satin Fill from the Stitch Toolbar. 
 Select Color 13. 
 Digitize one eye using two left clicks and press Enter to acti-

vate. Place your first click in the center of the eye and drag to 
the desired circumference of the circle, click again, and press 
Enter.  

 Press Esc; then right click on the eye and drag a quick clone 
and place over the other eye.  

 Click on Show Bitmap Artwork to hide the picture.  
 If you need to reshape any of your lines, now is the time to re-

shape because Advanced Appliqué objects cannot be re-
shaped.  

 Select the object you wish to reshape; select Reshape; move, 
add, delete, change control points as needed; then press Esc.  

Notes: 
 
Lesson covers: 

 Advanced Appliqué  

 Open Object digitizing  

Use this method whenever you 
need to digitize objects that have 
open objects within the design, 
for example, designs that are split 
into parts. Also use this method 
for designs that have dimensional 
accents within the appliqué. Final-
ly, use this method when you 
want to use other types of out-
lines besides single, zigzag, satin 
+ blanket.  
 
Backspace will erase one click at 
a time.  
 
Make sure that you create an un-
derlap when you digitize the ob-
jects underneath. It is important 
that the first and last digitized 
points are underneath the parts 
that will be on top of it.  
 
You must create all your edits 
before applying Advanced Ap-
plique because you cannot re-
shape Advanced Applique. 
 
Reshape:   

 To move, select the node; click 
and drag the node.  

 To change to the opposite node 
type, select the node; press the 
space bar.  

 To add, right or left click on the 
object’s outline.  

 To delete, select the node; 
press the Delete key. 

Advanced Appliqué 
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Applying Advanced Appliqué 
 Select the gray color chip in Color Film. 
 In the Applique Toolbox, click on Advanced Appliqué.  
 The Applique Properties dialog box will open. 
 White hatch marks should appear inside all parts of the elephant.  
 See Notes at the right if they do not.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Adding Fabrics to Advanced Appliqué  
 Once your elephant is covered with the white hatch marks, click on 

Place Fabric and Color in Patches in Applique Properties.  
 Click on the + sign in front of Benartex to open up the folder op-

tions.  
 Click on the + sign in front of Apple Butter. 
 If you rest your mouse on a fabric chip, the number will be dis-

played. 
 Select 568-4 (second color chip, sixth row). 
 Click on each part of the elephant to add the fabric.  

 
Merging Fabrics 
 Select Back at the bottom of the dialog box.  
 Select Merge Patches Together.  
 Click on the left ear and then the face to merge them; then click on 

the face and the right ear to merge those pieces; then click on the 
face and the trunk to merge the entire elephant. 

 Click on Back. 
 Select Close at the bottom of the dialog box.  
 Click on Show Appliqué Fabrics to show the fabric.  
 
 
Printing Appliqué Patterns 
 Select Print Preview. 
 Click on Options. 
 Make sure there is a check mark in front of Applique patterns. 
 Click OK in Print Options.  
 Click on Next Page if needed to find the Applique Pattern.  
 This page can be used to print a pattern that can be used if you wish 

to “scissor cut” your applique.   
 Click Close to close the Print Preview.  
 Select File> Save As and name the file Advanced Appliqué.  
 Close the file. 

Notes: 
 
If the white hatch marks do 
not appear in each part of the 
elephant, you must Reshape 
so that all lines overlap 
sufficiently.  
 
First select “Recover your 
original embroidery objects” 
from the Appliqué Properties 
dialog box. This will remove 
the advanced appliqué and 
you can reshape the individual 
objects of the design.  
 
Select the object to reshape; 
then click on Reshape to 
create more overlap of 
stitches. Check all overlaps. 
See below. 

Press Esc, and re-apply 
Advanced Applique by 
selecting the grey color chip in 
Color Film and then clicking 
on the Advanced Appliqué 
icon. Repeat reshape if 
needed.  
 
 
Merging fabrics lets you cut 
out larger pieces for the 
appliqué. You can only merge 
adjoining fabric patches that 
have the same color of fabric.   
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Combine Applique  

Open the Design 
 Click on Open.  
 Navigate to the location of the saved file from the Creator class 

called Applique.  
 Select it; click on Open.  

 
 
 

Combining Applique  
 Make sure Show Objects in Color Film is deactivated.  
 Hold the Ctrl key and select the blanket stitch applique and the 

scalloped petal and flower center in Color Film.  
 Click on Combine Applique. 
 Click OK in the dialog box that opens since you have already saved 

the design.  
 Placement lines for all applique objects are stitched in a single pass; 

then tackdown stitches will stitch and finally the cover.  
 The fabric is no longer visible because the software does not see 

this as an applique.  
 Save the file as Combined Applique.  
 If you open Object Properties, you can no longer access the 

Applique properties. This is why it is best to save the file before 
combining.  

Combine Applique is enabled 
when two or more appliques are 
selected. The selected objects are 
broken apart and the different 
components are combined for an 
efficient stitch out. It is recom-
mended to save the applique first 
before combining. Then it can be 
saved again as a Combined Ap-
plique.  
 
Non-applique items cannot be 
included in the selection.  
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 Special Effects 

Notes: 
 
Lesson covers: 

 3D Globe Effect 

 Textured Edge 

 Gradient Fill  

 Star Effect 

 Wave Effect 

 Carving Stamps 

 Alternating Patterns 

 Elastic Fancy Fill 

 Morphing  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The profiles determine how the 
gradient generates in the object. 

Open a New File 
 Select New Blank Design.  
 In the Digitize Toolbox, select the Rectangle Tool. 
 Click and drag from upper left to lower right. Click again to form a 

rectangle. 
 Press Esc. 
 Select the rectangle. 
 In the Transform Toolbar, unlock Proportional Scaling. 
 Change the Width to 2.75” and the Height to 5”. Press Enter.  
 Select the rectangle.  
 Select Array in the Mirror-Merge Toolbox.  
 Change the Columns to 5 and the Rows to 2.  
 Drag on screen and click to set the rectangles when there is no 

overlap of rectangles.  
 Click on Show Hoop to hide the hoop.  

 
3D Globe Effect 
 Select the first rectangle.  
 Right click on Pattern Fill in the Stitch Toolbar. 
 Click on Select.  
 In the Heirloom Pattern Set, select 738. Click OK; then OK again.  
 Click on 3D Globe. 
 Click on Reshape.  
 Click and drag on the control points around the circle to reshape 

the globe as desired.  
 Press Esc.  
 

Textured Edge 
 Select the second rectangle. 
 Click on Satin Outline.  
 Right click on the Textured Edge icon. 
 Place a check mark in the box by Textured Edge.  
 Click the Both Sides icon (the Side icon in the middle).  
 Drag the sliders to set the Texture and Span as desired.  
 Click OK.  
 

Gradient Fill  
 Select the third rectangle. 
 Double click to open Object Properties.  
 In the Stitch Angle tab, change the Stitch angle to 0 degrees. 

Press Apply.  
 Click on Effects in the lower left corner of Object Properties.  
 Choose the Gradient Fill tab.  
 Place a check mark by Gradient Fill. 
 Choose one of the four profiles. 
 Change the Maximum Spacing to 3 mm.  
 Click OK.  
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Notes: 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
If the software cannot adjust to 
the way the fill was reshaped, it 
will revert back to the default 
wave pattern.  

 
 

Star Fill Effect 
 Select the fourth rectangle.  
 Right click on the Star Fill effect.  
 Place a check mark in front of Star Fill.  
 Change the Hole Width to 5 mm and the Hole Height to 7 mm. 
 Click Apply.  
 Click on the Properties bar at the left corner of the Effects dialog box.  
 In the Fill Stitch tab, change the Stitch Spacing to 1.5 mm. 
 Click Apply.  
 Click on the Effects bar at the left corner of the Object Properties dia-

log box.  
 Select the Underlay tab. Uncheck Underlay 1. Click Apply. 
 Select the Others tab. Check Travel on Edges. Click OK.  
 While the rectangle is still selected, select Reshape.  
 Zoom into the hole. 
 Select the center yellow square.  
 Click and drag it to a new location. 
 Press Esc.  
 
Wave Fill Effect 
 Select the fifth rectangle.  
 Right click on Wave Fill. 
 Place a check mark by Wave Fill. Click OK.  
 Click on the Lacework Fill icon.  
 Select Reshape. 
 Move the control points by clicking and dragging on the control 

points. You may also add a control point by clicking on the reshape 
line. 

 Press Esc.  
 

Carving Stamp 
 Select the sixth rectangle. 
 Make sure you are in Artistic View. Select T on the keyboard if you 

are not in Artistic View.  
 If the Carving Stamp docker is not open, click on Carving Stamp.  
 Select the Use Pattern tab. 
 In the Pattern Set drop-down, select Carving Stamps category. 
 Scroll to find the heart; select it. 
 Click on Use Stamp under the preview screen. 
 Set the stamp on the rectangle using two left clicks. The stamp can 

be rotated by moving your mouse before clicking for the second time.  
 The stamp can be resized by holding the Shift key as you set the two 

clicks. Press Esc.  
 Select the rectangle. Click on Reshape. 
 Change the angle of the rectangle to 0 degrees by clicking and drag-

ging on a peach square until the angle reads 0 degrees. 
 You can also reshape the stamps by moving, resiz-

ing, or rotating. 
 Select the stamp to access the reshape options. 
 Experiment with each of these controls.  
 Press Esc.  
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Notes: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Holes can be added on the 
edge of shapes as well by digit-
izing a shape off the edge. 

Alternating Patterns 
 Select the seventh rectangle. 
 Right click on the Pattern Fill icon. 
 Click on Select.  
 In the Heirloom Pattern Set, select # 717. 
 Click OK; then Apply. 
 Place a check mark by Alternate Pattern in Object Properties.  
 Click on Select by Alternate Pattern.  
 From the Pattern Set, select Bernina V5. 
 Select NP005-01. 
 Click OK.  
 Change the Row Spacing to .250”. 
 Click OK.  
 
 

Color Blending 
 Select the eighth rectangle. 
 In the Edit Toolbox, select Color Blending.  
 Choose a Profile.  
 Choose a color for the Bottom layer and a contrast color for the Top 

layer. You may also change the spacing for each layer.  
 Click OK to activate.  
 If you want to change anything, click Undo. 
 Repeat the steps to create another color-blended object. 
 
 
 
Add Holes 
 Select the ninth rectangle. 
 In the Edit Toolbox, click on Add Holes.  
 Create holes by clicking within the object. 

Draw circles by right clicking at 12:00, 
3:00, 6:00, and 9:00. Press Enter to close 
each circle. 

 When you are done creating the holes, 
press Enter again to cut the holes.  

 To fill the holes, select the object.  
 Click on Fill Holes in the Edit Toolbox.  
 A dialog box opens if you wish to change 

the default underlap for the objects. The 
default value is 0.039”.  

 Click OK.  
 The holes are filled with the same color.  
 Select one of the holes; then using the 

Ctrl key, select the remaining holes. 
Change the color to a contrast color. 

 They can be moved in Color Film to stitch before the object with the 
holes, if desired.  

 Press Esc.  
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Notes: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Apply Closest Join will rear-
range the jump stitches in a 
design so that the jump stitches 
are shorter in between objects. 
It does not change the starts 
and stops of the first object; the 
starts and stops will change 
with subsequent objects. 

Knife 
 Select the Knife tool in the Edit Toolbox.  
 Click above the tenth rectangle so that you will be cutting it roughly 

into 1/3 + 2/3 sections.   
 Hold the Ctrl key and move the mouse to the lower part of the rectan-

gle. Click again.  
 Press Enter to cut the rectangle. Press Esc.  
 Select the right rectangle and use the arrow key to move the rectan-

gle to the right, separating the two.  
 
 
 

Elastic Fancy Fill 
 Change the larger shape to a Satin Fill. 
 Click on Reshape.  
 The angle should be 0 degrees.  
 Add a right click in the middle of each long side of 

the rectangle.  
 Move the control points to form a shape as shown 

on the right.  
 Press Esc.  
 Reselect the object. 
 Right click on the Elastic Fancy Fill icon. 
 Place a check mark by Elastic Fancy Fill.  
 Place a dot in front of Single Row, with scaling, lo-

cated under the preview window. Click OK.  

 
Morphing 
 Select the remaining narrow rectangle.  
 Select the Satin Outline icon.  
 If the Morphing Docker is not open, select the Morphing icon in the 

General Toolbar.  
 Select the Ripple icon.  
 Click and drag on the Amplitude and the Frequency sliders to distort 

the line.  
 Press Esc to deactivate. 
 Save the file as Special Effects.  
 The designs will need to be split for stitching.  
 
Note:  If you wish to stitch this file, separate it into three separate files 
for stitching.  

 Hold the Ctrl key and select the first two rectangles in the top row 
and the two rectangles below these. Select Cut.  

 Open a New Blank Design and select Paste.  
 Select Ctrl + A.  
 Click on Apply Closest Join in the Edit Toolbox.  
 Save the file as Special Effects 1.  
 Repeat the steps for the next four rectangles. Save as Special 

Effects 2.  
 Save the last file as Special Effects 3 after selecting the objects 

and clicking on Apply Closest Join.  
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